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Disclaimer 

 

The contents of this document are subject to change without notice. NEC Corporation assumes 

no responsibility for technical or editorial mistakes in or omissions from this document. To obtain 

the benefits of the product, it is the customer’s responsibility to install and use the product in 

accordance with this document. The copyright for the contents of this document belongs to NEC 

Corporation. Copying, altering, or translating this document, in full or in part, without the 

permission of NEC Corporation, is prohibited. 
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About this Guide 

Using this guide 

This guide provides a hands-on “Quick Migration” set of instructions to install and configure 

EXPRESSCLUSTER X (EC X) for Windows with Microsoft Exchange Server 2013 CU8. The 

guide assumes users have Microsoft Windows system administration knowledge and skills with 

experience in installation and configuration of Microsoft Windows operating systems, networks, 

and Exchange. It is also assumed that the user has a minimal Exchange Server 2013 

environment with the Mailbox and Client Access Roles on two separate servers. The server with 

the Mailbox Role will be clustered with EC X on a third server. 

 
This guide covers the following topics: 
 
Chapter 1: Overview – describes the general steps of setup procedures. 

 
Chapter 2: System Requirements and Planning – describes the overall system and network 

requirements, and includes a set of tables for planning the installation and configuration. 

 
Chapter 3: System Setup – describes the configurations required for each system before 

installing target application. 

 
Chapter 4: EC X Server Installation – describes EC X installation on the Primary and Standby 

Servers.  

 
Chapter 5: Base Cluster Setup – describes the process of generating a cluster, creating a 

failover group, and uploading a configuration.  

 
Chapter 6: Preparing Servers to Execute Scripts – describes configuration steps for preparing 

cluster nodes to execute EC X PowerShell failover scripts. 

 
Chapter 7: Microsoft Exchange Server 2013 Cluster Setup – describes required configuration to 

enable full cluster functionality.  

 
Chapter 8: Test Cluster and Verify Functionality – describes steps to verify and test the cluster 

and complete the deployment on a Primary and a Standby Server. 

 
Chapter 9: Common Maintenance Tasks – describes how to perform common maintenance 

tasks using the EC X Manager. 
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Where to go for more information 

Refer to additional documentation under the “documentation” directory on the  

EC X distribution CD. 

 

For more information, go to: http://www.nec.com/expresscluster 

 

Other EC X guides are at:  

http://www.nec.com/expresscluster/en/support/manuals.html  

 

 Getting Started Guide – General cluster concepts and overview of EC X functionality. 

 

 Installation and Configuration Guide – EC X installation and configuration procedures. 

 

 Reference Guide – Commands for EC X scripts and maintenance commands to 

execute from the command prompt. 

 

Contact: info@expresscluster.jp.nec.com  

 

 

 

 

 

 

 

 

 

 

 

 

  

http://www.nec.com/expresscluster
http://www.nec.com/expresscluster/en/support/manuals.html
mailto:info@expresscluster.jp.nec.com
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1 Overview 

The general procedure to deploy EC X on two servers (referred to as Primary and Standby) 

with Microsoft Exchange Server 2013, Mailbox role only, consists of the following major 

steps: 

 

1. Perform system planning to determine requirements and specify configuration settings 

prior to the start of actual system installation and configuration. 

2. Prepare the Standby Server, including OS installation and configuration with Exchange 

Server 2013 Mailbox role installation and configuration. 

3. Install and configure EC X on the Primary and Standby Servers. 

4. Create and configure the EC X failover group to enable continuous protection and 

automatic recovery for mailbox database. 

5. Upload the configuration file and start the cluster to complete deployment in the mirror disk 

configuration. 
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2 System Requirements and Planning 

2.1 System Requirements 

Machine 1: Primary Server (with Exchange Server 2013 Mailbox role) 

Machine 2: Standby Server (with Exchange Server 2013 Mailbox role) 

Machine 3: Test Client (a machine with an email client) 

 

  

Machine 1 

Primary Server 

 

Machine 2 

Standby Server 

 

Machine 3 

Test Client 

 

Memory 

 

8GB or more 

 

 

1GB or more 

 

Disk 

 

1 physical disk 

 

OS partition: 50GB or more space 

available (to include the installation of  

Microsoft Exchange Server 2013) 

 

Cluster partition: Partition of 17MB or 

more, available for EC X Management –  

the same size for each server system 

 

Data partition: Enough partition space to 

store mailbox database 

 

 

1 physical disk with 30GB or more 

space available 

 

OS 

 

Windows Server 2012 R2 (Standard or 

Datacenter) with the latest Service Pack 

 

Windows 7 or newer  

 

Software 

 

Java Version 6.0 Update 20 (or later) 

enabled Web browser 

Microsoft Exchange Server 2013 CU8 

 

Java Version 6.0 Update 20 (or later) 

enabled Web browser 

 

Network 

 

 

 

2 – 100Mbit or faster Ethernet network  

interface cards 

 

1 – 100Mbit or faster Ethernet network 

interface card 
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2.2 System Planning 

Review the requirements from the last section and then fill in the tables of the worksheet below. Refer to 

Appendix B: Example System Planning Worksheet for an example worksheet.  This is useful when creating 

the cluster later. 

 

Machine 1: Primary Server (with Mailbox role of Exchange Server 2013) 

Machine 2: Standby Server (with Mailbox role of Exchange Server 2013) 

Machine 3: Test Client (a machine with an email client) 

 

Table 1: System Network Configuration 

Machine Host name 
Network 

Connection 
IP Address 

Subnet 

Mask 

Default 

Gateway 

Preferred 

DNS Server 

1 

 Public:     

Interconnect:     

2 

 Public:     

Interconnect:     

3       

 

Mailbox Database Name: _________________ 

 

Floating IP (FIP) address:  

Web Management Console FIP:  ______________ 

 

Table 2: System OS and Disk Configuration 

Machine OS Disk 0 (OS Disk) Disk 1 (Data Disk) 

1 

  

Boot Partition: 

Drive Letter:  

Size:  

  Cluster Partition: 

   Drive Letter: 

   Size (>20MB) : 

 

 *Data Partition: 

  Drive Letter: 

  Size: 

2 

  

Boot Partition: 

Drive Letter:  

Size:  

 

3 

 

 

   

 

* The size must be large enough to store all data, and log files for a given Microsoft Exchange Server 2013 

installation to meet current and expected future needs.   
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Table 3: System Logins and Passwords 

 

Computer/Account 

 

Login 

 

Password 

 

Machine 1  

Administrator 

  

 

Machine 2  

Administrator 

  

 

Machine 3  

Administrator 

  

 

Domain 

Administrator 
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3 System Setup Preparation 

3.1 Set up the Standby Server (Machine 2) 

1. If necessary, install hardware components, OS, and Service Packs identical to the 

Primary Server (Machine 1). 

2. Install and configure Exchange Server 2013 with the latest cumulative update and 

only with the Mailbox Role. 

3.2 Additional setup on Primary Server (Machine 1) and Standby Server (Machine 2) 

Network Interface 

1. The network interface to which the two servers should be connected to a network 

will be referred to as Public. If possible, set up a second network interface on both 

servers to be used for internal EC X management and data mirroring network 

communication between these two servers. This second network interface will only 

be shared by these two servers and will be referred to as Interconnect. 

2. In the Network connections windows of each server, change the network interface 

binding order so that the Public network is in the first position. 

 

Data Disk (Mirror Disk) 

1. Make sure the disk device or LUN is initialized as a Windows Basic disk device. 

2. Create a mirrored disk cluster partition for EC X management on the disk which is 

17MB or greater. Assign a drive letter to the partition, but do NOT format (refer to 

Table 2: System OS and Disk Configuration). The size MUST be the same on both 

servers. 

3. Create a mirrored disk data partition on the disk. Assign a drive letter to the partition 

and format to NTFS (refer to Table 2: System OS and Disk Configuration). The size 

MUST be the same on both servers. 

4. Verify the mirrored disk cluster and data partitions are visible in Windows Explorer 

under their assigned drive letters. 
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4 EC X Server Installation 

4.1 Install EC X on the Primary Server (Machine 1) 

1. Insert the EXPRESSCLUSTER X CD-ROM into a CD-ROM drive on the server. 

2. In the pop-up window, click NEC EXPRESSCLUSTER for Windows. 

3. Click on NEC EXPRESSCLUSTER X 3.x for Windows. 

4. In the Welcome window, click Next. 

5. In the Choose Destination Location window, click Next. 

6. In the next window, click Install. 

7. In the Port Number window, if necessary, modify the default port numbers. Click 

Next.  

8. In the Filter Settings of Shared Disk window, click Next. 

9. In the Confirmation window, click Yes. 

10. In the License Manager window, click Register. 

11. In the License Registration window, click Register with License Information. 

12. In the Product Selection window, select the OS and Product/Trial types. For 

Product Name, click EXPRESSCLUSTER X 3.x for Windows. Click Next. 

13. In the License Unit Selection window, depending on the type of license, enter the 

number of CPU or Node Units. Click Next. 

14. In the License Key Entry window, enter the Serial No. and License Key. Click 

Next. 

15. In the License Registration Confirmation window, confirm the information entered 

is correct. Click Next. 

16. Click OK. If the license registration fails, start again from step 10. 

17. Repeat steps 10-16 again for the EXPRESSCLUSTER X Replicator 3.x for 

Windows product license. Select EXPRESSCLUSTER X Replicator 3.x for 

Windows as the Product Name in step 12. 

18. In the next window, click Finish. 

19. On the InstallShield Wizard Complete window, click the No, I will restart my    

computer later option button, and then click Finish. 

20. In the next window, click Exit. Click Exit. (Two times total). 

4.2 Install EC X on the Standby Server (Machine 2) 

Perform all of the steps in Section 4.1 on the Standby Server. 

4.3 Restart the Primary and Standby Servers (Machines 1 & 2) 

First restart the Primary Server, and then restart the Standby Server. 
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5 Base Cluster Setup 

5.1 Install Java Runtime Environment (JRE) 

Verify JRE Version 6.0 Update20 or newer is installed on a machine to be used for 

cluster management. Also install on the nodes (Machine1 and Machine2) if they might 

be used for cluster management. If necessary, install JRE by performing the following 

steps: 

 

1. Run jre-<build and platform version>.exe (a compatible JRE distribution is in the 

jre folder on the EXPRESSCLUSTER CD). 

2. In the License Agreement window, verify the default Typical setup option button is 

selected. Click Accept. 

3. On the Installation Completed window, click Finish. 

5.2 Start the EC X Cluster Manager 

Start by accessing port 29003 of the Primary Server from the Web browser of the 

cluster management machine, using the Primary Server’s IP address. Example: 

http://10.1.1.1:29003. When the security warning window displays, select the Always 

trust content from this publisher check box. Click Run. 

5.3 Create a cluster 

For all of the steps below, refer to Table 1: System Network Configuration for the IP 

addresses and server names. 

 

1. When the cluster manager is opened for the first time, there is a pop-up window with 

two options. Click Start cluster generation wizard. 

2. In the next window click Start Cluster Generation Wizard for standard edition. 

3. In the new window, type a cluster name. (Example: cluster). 

4. Type the Management IP address, and click Next.  

5. In the next window, to add another server to the cluster, click Add. 

6. Type the hostname or the IP address of the Standby Server, and then click OK. 

7. Both servers are now on the list. If the Primary Server is not in the top (Master 

Server) position, then move it up. Click Next. 

8. EC X automatically detects the IP addresses of the servers. Select the network to 

use the Heartbeat path in the Kernel Mode type. The primary network is for 

mirroring the data; set Type to Mirror Communication and the MDC as mdc1. Click 

Next. 

9. In the NP Resolution window, click Next. 
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5.4 Create a failover group 

For all of the steps below, refer to Table 1: System Network Configuration for the IP 

addresses and server names.  

1. To add a group, in the Cluster Generation Wizard, in the Group section, click Add. 

2. In the next window, select failover for group Type. Name the group (Example: 

Exchange_Failover), click Next, and then click Next. (Two times total). 

3. Select the default options for the Group Attribute Settings, and then click Next. 

5.5 Create Mirror Disk Resource 

1. In the Group Resource section of the Cluster Generation Wizard, to add a 

resource, click Add. 

2. In the next window, Click Get License Info to retrieve the active license for 

replication. (Note that there is no visible indication that it was successful) 

3. To add a mirror disk resource (md), from the drop-down menu, select mirror disk 

resource, and then click Next. 

4. Verify the Follow the default dependency box is selected, and then click Next. 

5. Verify the default options are correct, and then click Next. 

6. Click Add to add the first server. 

7. Click Connect to populate the server partitions. 

8. Select the data and cluster partitions. Click OK. 

9. Repeat steps 6-8 for the second server. 

10. Click Finish. 

11. Click Finish, and then click Next. 

12. Click Finish. 

13. Click Yes to enable recovery action when an error occurs in a monitor resource. 

5.6 Upload the cluster configuration and initialize the cluster 

1. In the Cluster Manager window, click the File menu and then Apply the 

Configuration File. Click OK. Click OK. (Two times total). 

2. After the upload is complete, change from Config Mode to Operation Mode. 

3. Restart Cluster Manager. Click the Service menu, and then click Restart Manager. 

Click OK. 

4. Click the Service menu, and then click Start Cluster. Click OK. 

5. When the cluster tree displays after a few seconds, in the left pane of the Cluster 

Manager window, expand the %failover group% section, right click %mirror disk%, 

and click Details to monitor the disk synchronization progress. Mirror disk copy starts 

automatically, replicating data from the Primary Server to the Standby Server. 
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Note 

This step may take a while depending on the size of the data in the mirrored disk 

data partition. 

 

6. After the copy completes, in the Mirror Disk Helper window, click Close. 

7. In the Cluster Manager window, all icons in the tree view are now green. Refer to 

the figure below. 

 

 

8. Confirm that the cluster is functioning. Move the failover group to the Standby 

Server and then move the failover group back to the Primary Server (See Section 

9.3). 

 

Note 

This test does not affect server functionality. It verifies that the mirror disks on each 

server in the cluster are functioning properly. The mirror disk is now controlled by EC 

X and is only accessible from the active server. 

 

 

 

  



 

EXPRESSCLUSTER X  for Windows – Microsoft Exchange Server 2013 Migration 16 

 

6 Preparing Servers to Execute Scripts 

6.1 Set Powershell’s Script Execution Policy 

1. Launch PowerShell on the Primary Server. 

2. Use Get-ExecutionPolicy to check the current script execution policy. 

3. Set the execution policy to RemoteSigned or Unrestricted using Set-

ExecutionPolicy in order to run EC failover scripts. 

 

PS> Set-ExecutionPolicy RemoteSigned 

 

4. Repeat this process on the Standby Server. 

6.2 Create Copy of RemoteExchange.ps1 and Modify the Copy 

1. Navigate to the Exchange ‘Bin’ folder (e.g. C:\Program Files\Microsoft\Exchange 

Server\V15\Bin) on the Primary Server. 

2. Copy RemoteExchange.ps1 to the same folder and rename the copy to 

RemoteExchange-ECX.ps1. 

3. Edit RemoteExchange-ECX.ps1 by adding the line .\ControlMailboxDatabase.ps1 

to the section where the functions are called. Comment out get-banner and get-tip 

in this section. Also add the error handling code as shown in the example below. 

 

## now actually call the functions 

 

#get-exbanner 

#get-tip 

 

$ErrorControlMailboxDatabase = 90 

 

.\ControlMailboxDatabase.ps1 

$bRet = $? 

if ($bRet –eq $False) 

{ 

                exit $ErrorControlMailboxDatabase 

} 

 

4. Repeat this process on the Standby Server. 
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7 Microsoft Exchange Server 2013 Cluster Setup 

To configure the Microsoft Exchange Server 2013 cluster, move the mailbox database to the 

data partition and change the path using the Exchange Management Shell on the Primary 

Server (Machine 1). 

7.1 Move the Mailbox Database from Default Location to Data Partition 

1. Create a folder (Mailbox Folder) on the Data Partition (example: X:\Mailbox Folder). 
2. Before moving the Mailbox Database and LogFolderPath, make a backup copy of all 

files. 
3. Once the backup is made, launch the Exchange Management Shell. 
4. Run the following command at the prompt: 

 
Move-DatabasePath –Identity <Mailbox database name> -EdbFilePath <new path 
to .edb file> -LogFolderPath <new path to folder> 
 
Example: Move-DatabasePath –Identity “Mailbox01” –EdbFilePath “X:\Mailbox 
Folder\Mailbox01.edb” –LogFolderPath “X:\Mailbox Folder” 
 
Refer to the figure below: 
 

 

 
Note: This is a good opportunity to rename the mailbox database from the default 
name if not done previously. 

 

5. Run the following command at the prompt: 
 
Set-MailboxDatabase –Identity <Mailbox database name> –MountAtStartup $False 
 

6. To verify the change, run the command (using mailbox name in example above): 

 
Get-MailboxDatabase  <Mailbox database name> | Fl Name,*Path*,MountAtStartup 
 

7. Run the command below if the mailbox database needs to be mounted: 

 
Mount-Database –Identity <Mailbox database name> 
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7.2 Configure services on the Primary Server (Machine 1) 

1. Right-click Start and then click Run. 

2. Type services.msc and click OK to open the Services management console. 

3. Right-click on the service Microsoft Exchange Search Host Controller and then 

select Properties. 

4. Set the Startup type to Disabled and then Stop the service. 

5. Repeat this process on the Standby Server (Machine 2). 

 

7.3 Copy and configure failover scripts 

1. Download the script files from NEC web site; 

http://www.nec.com/en/global/prod/expresscluster/en/support/Setup.html. 

2. Copy all script files to the EXPRESSCLUSTER bin folder (example. C:\Program 

Files\EXPRESSCLUSTER\bin) on the Primary Server. 

3. Open SetEnvironment.bat with a text editor and change the parameters to match 

your environment. 

4. Repeat the previous two steps on the Standby Server. 

 

Note 

One of the scripts requires that the Active Directory module for Windows 

PowerShell feature is installed. Verify this on both servers before continuing by 

accessing:  Remote Server Administration Tools > Role Administration Tools > AD 

DS and AD LDS Tools > Active Directory Module for Windows PowerShell 

 

7.4 Adding Application Resources to Control a Mailbox Database 

1. Start the EC X Cluster Manager. 

2. In the Cluster Manager window, change to Config Mode. 

3. Right-click on the %failover group%, and then click Add Resource to add the first 

application resource. 

4. From the drop down list, select application resource for Type, and give a name to 

the resource (example: appli-check-service). Click Next. 

5. Uncheck Follow the default dependency and click Next. 

6. Click Next if the default values are acceptable. Make changes to Retry Count or 

Failover Threshold first if necessary. 

7. Check Non-Resident and set the following parameter for Start Path. 

Start Path : CheckExchangeServices01.bat 

Stop Path : (NULL) 

http://www.nec.com/en/global/prod/expresscluster/en/support/Setup.html
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8. Click Tuning and set 0 for Normal Return Value and set a Timeout value of at least 

3600 for Start on the Parameter tab (see Note below). Click OK and then click 

Finish. 

 

Note 

The 1st application resource (example. appli-check-service) uses the following 

parameters in SetEnvironment.bat to wait for all Exchange services to be running. 

RetryCount : 30 

RetryInterval : 60 

By default, the application resource waits 1800 (= RetryCount x RetryInterval) 

seconds for all Exchange services to be running. If any services are not running, the 

application resource starts them and waits 1800 seconds for them to be running. 

Services can take up to 3600 seconds to start. It is recommended to set the 

Timeout value to 3600 or longer (= RetryCount x RetryInterval + some buffer). 

9. Right-click on the %failover group%, and then click Add Resource to add the 

second application resource. 

10. From the drop down list, select application resource for Type, and give a name to 

the resource (example: appli-control-AD). Click Next. 

11. Uncheck Follow the default dependency. Click the first application resource 

(example: appli-check-service) and click Add. Click Next. 

12. Click Next if the default values are acceptable. Make changes to Retry Count or 

Failover Threshold first if necessary. 

13. Check Non-Resident and set the following parameter for Start Path. 

Start Path : ControlActiveDirectory01.bat <Mailbox database name> 

Stop Path : (NULL) 

14. Click Tuning and set 0 for Normal Return Value of Start on the Parameter tab.  

15. Click the Start tab and set the following parameters. 

Domain : your domain name 

Account : a user belonging to the Schema Admins group 

Password : password for the above user 

16. Click OK and then click Finish. 

17. Right-click the mirror disk resource (md) and click Properties. 

18. Select the Dependency tab and uncheck Follow the default dependency. Click the 

second application resource just created (example: appli-control-AD) and click Add. 

Click OK. 

19. Right-click on the %failover group%, and then click Add Resource to add the third 

application resource. 

20. From the drop down list, select application resource for Type, and give a name to 

the resource (example: appli-control-DB). Click Next. 
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21. Uncheck Follow the default dependency. Click the mirror disk resource and click 

Add. Click Next. 

22. Click Next if the default values are acceptable. Make changes to Retry Count or 

Failover Threshold first if necessary. 

23. Check Non-Resident and set the following parameters for Start Path and Stop 

Path. 

Start Path : ControlMailboxDatabase01.bat <Mailbox database name> Mount 

Stop Path : ControlMailboxDatabase01.bat <Mailbox database name> Dismount 

24. Click Tuning and set 0 for Normal Return Value of both Start and Stop on the 

Parameter tab. 

25. Click the Start tab and set the following parameters. 

Domain : your domain name 

Account : a user belonging to the Organization Management1 group 

Password : password of the above user 

26. Click the Stop tab and set the following parameters. 

Domain : your domain name 

Account : a user belonging to the Organization Management group 

Password : password of the above user 

27. Click OK and then click Finish. 

28. Click the Entire Dependency tab in the right pane and check the dependencies. See 

example below. 

 

Depth Resource Name 

0 1st application resource appli-check-service 

1 2nd application resource appli-control-AD 

2 Mirror disk resource md 

3 3rd application resource appli-control-DB 

 

7.5 Upload the cluster configuration and start the cluster. 

1. First dismount the mailbox database using Exchange Administrative Center or the 

following command in the Exchange Management Shell before starting the cluster. 

 

Dismount-Database –Identity <Mailbox database name> 

 

2. Then in the Cluster Manager window, click the File menu, and then Apply the 

Configuration File. Click OK. Click OK. 

                                                 
1
 The Organization Management group belongs to Microsoft Exchange Security Group. 
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3. After the upload is complete, change to the Operation Mode. 

4. Right-click on the %failover_group% and select Start. Select the Primary Server to 

start the group on and click OK. The mailbox database will mount on this server. If 

the cluster is not running, click the Service menu, and then click Start Cluster. Click 

OK. 

 
Note 
There is no need to make changes to Microsoft Outlook or OWA.  
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8 Test Cluster and Verify Functionality 

1. Verify the Primary Server is running with mailbox database mounted and the Standby 

Server is also running, but with no mailbox database mounted. The status can be 

checked by using Exchange Administrative Center or the following command in the 

Exchange Management Shell.  

 

Get-MailboxDatabase -Status -Identity <Mailbox database name> | FL –Property 

Name,Mounted,MountedOnServer 

 

2. With the cluster started on the Primary Server, try accessing the mailbox database from 

an email client such as Microsoft Outlook or OWA. 

 

Test 1: Move Failover Group to Standby Server 

1. Move the failover group to the Standby Server (refer to 9.3). Monitor the failover 

process in the Cluster Manager window. Verify that email clients are still able to 

connect to the mailbox database. 

2. Move back the failover group to the Primary Server (refer to 9.3). Verify that email 

clients are still able to connect to the mailbox database. 

 

Test 2 (Optional): Force Failover to Standby Server 

1. Shutdown the Primary Server (refer to 9.2). This will initiate a failover to the 

Standby Server. Email clients should still be able to connect to the mailbox 

database. The default setting for server recovery is to automatically rejoin the 

cluster. If manual recovery is preferred, refer to 9.4 to change this setting. Return 

the Primary Server to the cluster by turning on the power (refer to 9.5). Move 

Failover Group back to Primary Server. 
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9 Common Maintenance Tasks 

9.1 Start Cluster Manager 

There are two methods to start/access Cluster Manager through a supported Java 

enabled Web browser.  

 

Start  Internet Explorer or any other supported Java enabled Web browser. 

 

Method  1: Type the URL with the IP address of an active EC X clustered server; a 

colon (:); and then the cluster server port number. 

Example: http://10.1.1.1:29003/ 

Use during or after the initial setup. 

 

Method  2: Type the URL with the Management IP which was set up during EC X 

installation; a colon (:); and then the cluster server port number. 

Example: http://10.1.1.3:29003/ 

Use after the initial setup and while the cluster is running. 

 

9.2 Shutdown/Reboot one or all cluster servers 

Start Cluster Manager (refer to 9.1) and do the following action. 

 

- Shutdown one server. 

Right-click the %machine name%, and then click Shutdown. 

 

- Shutdown all servers 

Right-click the %cluster name%, and then click Shutdown. 

 

- Reboot one server 

Right-click the %machine name%, and then click Reboot. 

 

- Reboot all servers 

Right-click the %cluster name%, and then click Reboot. 

 

9.3 Startup/stop/move failover groups 

1. Start Cluster Manager (refer to 9.1). 

2. Under Groups, right-click %failover group% and then click Start/Stop/Move. 

3. In the Confirmation window, click OK. 
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9.4 Isolate a server for maintenance 

1. Start Cluster Manager (refer to 9.1). 

2. In the Cluster Manager window, change to Config Mode. 

3. Right-click the %cluster name%, and then select Properties.  

4. Click the Auto Recovery tab. To manually return the server to the cluster, select 

Off for the Auto Return option. Otherwise, leave it set to On for automatic 

recovery when the server is turned back on. Click OK. 

5. If a change was made, upload the configuration file. 

6. Shut down the server to isolate for maintenance (refer to 9.2). The server is now 

isolated and ready for maintenance tasks. 

 

 

9.5 Return an isolated server to the cluster 

Refer to 9.4 for setting recovery options. 

9.5.1 Automatic Recovery 

1. Turn the machine back on.  

2. Recovery starts automatically to return the server to the cluster.  

9.5.2 Manual Recovery 

1. Turn the machine back on and wait until the boot process is complete. 

2. Start Cluster Manager. 

3. In the Cluster Manager window, right-click the name of the isolated  

      server, and then select Recover. The isolated server returns to the cluster. 

9.6 Rebuild a mirror disk 

1. Start Cluster Manager (refer to 9.1).  

2. In the Cluster Manager window, in the left pane, right-click Servers and then 

click Mirror Disks. 

3. In the Mirror Disks window, click the Details button. 

4. In the next window, click the button below the %machine name% of the machine 

to copy files from [Primary Server (Machine 1)] and then click the button below 

the %machine name% of the machine name of the destination server to copy 

files to [Standby Server (Machine 2)]. 

5. Click the Execute button. In the Confirmation window, click OK. 
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Appendix A: EC X Server Uninstallation 

 

1. In the EC X Cluster Manager window of the web browser click the Service menu, and 

then click Stop Cluster. 

2. Close the web browser with Cluster Manager. 

3. Stop all EC X services on the server where the uninstall process will be run. To stop all 

services, follow the steps below: 

a. On the Start menu, point to Administrative Tools, and then click Services. 

b. In the right pane, scroll down and double-click the entry for EXPRESSCLUSTER. 

Click the Stop button. 

c. In the Stop Other Services window, click Yes. Click OK. 

d. Repeat step 3.b. above for the entry for EXPRESSCLUSTER EVENT, and then 

click OK. 

4. On the Start menu, click Control Panel. Click Uninstall a program. 

5. In the Uninstall or change a program window, under the list of Currently installed 

programs, click NEC EXPRESSCLUSTER Server. Click Uninstall. 

6. To start the uninstall process, in the Confirmation window, click Yes. 

7. In the next window, click Yes to reset the registry settings to disable the media sense 

functions of TCP/IP disconnect detection. 

8. In the first Install Wizard Complete window, click Finish. 

9. On the next Install Wizard Complete window, select the Yes, I want to restart my 

computer now option button. Click Finish. This completes the uninstall process for an 

individual server system. 

 

Note 

To uninstall an EC X Server, you must be logged on as an administrator or have an 

account with administrator privileges. 

 

After the installation is complete, if any shared disks are in use, unplug all disk cables 

connected to the servers. 
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Appendix B: Example System Planning Worksheet 

Machine 1: Primary Server (Exchange Server 2013 with Mailbox Role) 

Machine 2: Standby Server (Exchange Server 2013 with Mailbox Role) 

Machine 3: Test Client (a machine with an email client) 
 

Table 1: System Network Interfaces 

Machine Host name 

 

Network 

Connection 

IP Address Subnet Mask 

 

Default 

Gateway 

Preferred 

DNS 

Server 

 

1 

 

 

Primary 
 

Public 
Interconnect 

 

10.1.1.1 

192.168.1.1 

 

255.255.255.0 

255.255.255.0 

 

10.1.1.5 

---------- 

 

10.1.1.5 

----------- 

 

2 

 

Standby 

 

Public 
Interconnect 

 

10.1.1.2 

192.168.1.2 

 

255.255.255.0 

255.255.255.0 

 

10.1.1.5 

---------- 

 

10.1.1.5 

---------- 

3 Test Client Public 10.1.1.6 255.255.255.0 10.1.1.5 10.1.1.5 

 

Table 2: System OS and Disks 

 

Machine 

                      

OS         

  

Disk 0 (OS Disk) 

 

Disk 1 (Data Disk) 

 

       1 
 

Win Server 2012 R2 

Std. Ed. or later 

 

Boot Partition: 

Drive Letter: C 

Size: 75GB            

 
* Cluster Partition: 

   Drive Letter: W 

   Size: 24MB              

 

  Data Partition: 

  Drive Letter: X   

  Size: 50GB 

 

       2 
 

Win Server 2012 R2 

Std. Ed. or later 

 

Boot Partition: 

Drive Letter: C 

Size:  75GB            

 

       3 

 

Win 7 or later 

 

C: 30GB 

 

 

* Must be a raw partition and larger than 17MB. 
 

Mailbox Database Name:   Mailbox01 

 

Floating IP (FIP) address:  

Web Management Console FIP:  10.1.1.3 

 

Table 3: System Logins and Passwords 

Computer/Account Login Password 

Machine 1 

Administrator 
Administrator admin1234 

Machine 2 

Administrator 
Administrator admin1234 

 


	Using this guide
	Where to go for more information
	1 Overview
	2  System Requirements and Planning
	2.1 System Requirements
	2.2 System Planning

	3  System Setup Preparation
	3.1 Set up the Standby Server (Machine 2)
	3.2 Additional setup on Primary Server (Machine 1) and Standby Server (Machine 2)

	4 EC X Server Installation
	4.1 Install EC X on the Primary Server (Machine 1)
	4.2 Install EC X on the Standby Server (Machine 2)
	4.3 Restart the Primary and Standby Servers (Machines 1 & 2)

	5  Base Cluster Setup
	5.1 Install Java Runtime Environment (JRE)
	5.2 Start the EC X Cluster Manager
	5.3 Create a cluster
	5.4 Create a failover group
	5.5 Create Mirror Disk Resource
	5.6 Upload the cluster configuration and initialize the cluster

	6 Preparing Servers to Execute Scripts
	6.1 Set Powershell’s Script Execution Policy
	6.2 Create Copy of RemoteExchange.ps1 and Modify the Copy

	7 Microsoft Exchange Server 2013 Cluster Setup
	7.1 Move the Mailbox Database from Default Location to Data Partition
	7.2 Configure services on the Primary Server (Machine 1)
	7.3 Copy and configure failover scripts
	7.4 Adding Application Resources to Control a Mailbox Database
	7.5 Upload the cluster configuration and start the cluster.

	8  Test Cluster and Verify Functionality
	9 Common Maintenance Tasks
	9.1 Start Cluster Manager
	9.2 Shutdown/Reboot one or all cluster servers
	9.3 Startup/stop/move failover groups
	9.4 Isolate a server for maintenance
	9.5 Return an isolated server to the cluster
	9.5.1 Automatic Recovery
	9.5.2 Manual Recovery

	9.6 Rebuild a mirror disk

	Appendix A: EC X Server Uninstallation
	Appendix B: Example System Planning Worksheet

